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ABOUT THIS GUIDE

Many customers have requested support for customized deployment of MindManager to large numbers of
client machines. This document provides complete information about large-scale deployments.

Topics include:

Running the standard setup manually or automatically (page 2)

Running the admin setup manually or automatically (page 2)
MindManager components (page 4)

Deploying using the installation wizard (page 18)

Deploying from the command line (page 24)

Deploying with Windows Active Directory (limited support) (page 34)
Deploying with Windows Server running Terminal Services (page 36 )
Deploying with Citrix Presentation Server (page 37)

Note: Installing MindManager on a Shared network Drive is not supported.

Note: To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise.

MindManager Support Help

For technical support with this product, go to http://www.mindjet.com/support. Here you will find links to
the Knowledge Base articles, User Forums, and other online resources. You can also submit a support
request for additional assistance.
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SYSTEM REQUIREMENTS FOR
MINDMANAGER INSTALLATION

Table 1: Installation Requirements

ADDITIONAL REQUIREMENTS TO USE

REQUIREMENTS

= |BM® or
compatible
Pentium®
processor (1 GHz
or greater)

= 2GBRAMor
greater

= 830 MB disk
space

=  SVGA (1024 x
768/16-bit color or
greater)

=  Microsoft .NET 4.0
or higher

SUPPORTED OPERATING SYSTEMS

Microsoft® Windows® 8
and 8.1 32-bit and 64-bit*
Microsoft® Windows® 7
and 7.1 32-bit and 64-bit*
(includes Service Pack 1
released in Feb, 2011)

Large Scale Deployments

Citrix MetaFrame
Presentation Server 4.5
and above (e.g. 5.0)
Citrix XenApp Version 6
Microsoft Windows
Server 2008 R2 64-bit
and later

Microsoft Windows
Server® 2003 32-bit

CERTAIN FEATURES

Microsoft Office
Professional 2003, 2007,
2010, or 2013 (32-bit and
64-bit)

Microsoft Project® 2003,
2007, 2010, or 2013 (32-
bit and 64-hbit)

Microsoft SharePoint
2010 Enterprise, Standard
and Foundation servers *
Mozilla® Firefox® 9.0 or
greater

Google Chrome™ 16.0 or
greater

Adobe® Acrobat® 9.2 or
greater

Adobe Flash® Player 10
or greater

Broadband Internet
Connection

* To use MindManager with
Microsoft SharePoint, you must
purchase and install MindManager
Enterprise.

If deploying MindManager in a terminal server environment, the following are prerequisites:
=  Windows Server 2008 running Terminal Services
or
= Citrix MetaFrame Presentation Server 4.5 and above 32-bit, or XenApp 6 64-bit

Using this method, each client machine must also meet the software and hardware requirements. When
running MindManager on a terminal server, the client must be able to connect and handle RDP. The
server requirements depend on the number of clients.
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UNDERSTANDING DEPLOYMENT
STRATEGIES

This section provides an overview of different deployment strategies, including their basic technologies,
advantages, limitations, and their level of support.

Running the Standard Setup Manually or Automatically

You can deploy MindManager on a machine-by-machine basis using the standard setup
(MindManager.exe) by installing from the physical CD, or from a centrally accessible server. The
standard setup is robust, interactive, and user-friendly, but does not support customized deployment.

Using the standard setup has these advantages:

= MindManager installs and operates properly on supported systems
= |t requires no additional software or server resources
= Users with local administration privileges can manage the update process individually

And these disadvantages:

= Manual installation is time-consuming
» The installed software uses up disk space on each user's system
» Centralized administration becomes more difficult

Running the Admin Setup Manually or Automatically

The MindManager Admin setup provides more control over installation and administration. You can run
the admin setup from a server manually, or via a log-on script. If you use Windows Active Directory,
Group Policy, and IntelliMirror, you can install on groups of user systems.

Using the admin setup has these advantages:

MindManager installs and operates properly on supported systems

It requires no additional software or server resources

You can customize installations on a per-group or per-user basis

You can run the installation silently

The installer is not cached on the client machine, reducing the required disk space

And these disadvantages:
= Access to the original installer is required for repair and other setup operations
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Other Deployment Options

Deploying with Active Directory

This method is not yet fully supported. Due to the application architecture, MindManager only supports
Computer-based Software installations via Active Directory. User-based deployment is not supported.
Using a third party tool such as Orca allows you to edit properties for deployment. For more information,
see Deploying with Active Directory, page 34.

Deploying with Windows Server

Deploying MindManager from a terminal server to a thin client is another supported option. With this
architecture, it is possible (for example), to “run” a Windows application on a Windows client machine,
where one server services many clients. You need to deploy MindManager using Windows Server
Terminal Services to use full color mode in MindManager. For more information, see Deploying with
Windows Server, page 36.

Deploying with Citrix Presentation Server

The Citrix MetaFrame Presentation Server is a sophisticated terminal server environment built on top of
the Windows Terminal Services provided by Windows Server. This is currently the only tested and
supported Citrix platform for MindManager (although other combinations may work). For more
information, see Deploying with Citrix Presentation Server, page 37.

Using System Management Software and a Custom Setup

System management software, such as Microsoft System Management Server, enables you to centrally
install and administer client machines. While you can deploy MindManager using such software, there is
no specialized support for this in MindManager. This document supplies much of the information you will
need if you choose to deploy in this way.

Using system management software has these advantages:

* You can deploy the software to many machines with one command
* You can create different setups for different groups of users
» Updating the software is simple

And these disadvantages:

= You must have system management software in place
= |t takes time to create the custom setup
= The installed software uses up disk space on each user's system

Deploying on a Shared Network Drive

MindManager does not support installing on a shared network drive and having users run it directly from
there.

MindManager Large Scale Deployment Guide © 2014 Mindjet. All Rights Reserved
Document Version 15.0
September 11, 2014 3



WHAT GETS INSTALLED

The Admin setup installs:

Required program files
Configurable components
Shortcuts and Start Menu items
Third-party add-ins or components
Shared system software

Registry keys

The default location for required program files is:
C:\Program Files\Mindjet\MindManager 14

This folder contains MindManager.exe, application DLLs, and third party components. No user files are
stored in this folder.

MindManager uses merge modules to install required system software, such as ATL80.dII. If
MindManager uses a later version of a component than one already installed on the machine,
MindManager installs the required version during deployment. For more information, see Shared System
Software, below.

The first time a user runs the application, user data is placed in the default location C:\Documents and
Settings\UserName\Local Settings\Application Data\Mindjet\MindManager\14, where UserName is
the current user name. You must enable viewing hidden files to see this directory. Note: This will be
different on XP versus newer versions of Windows, but the principle is the same.

The first time a user starts the application, the application also searches to determine if a Microsoft Office
custom dictionary exists for that user (e.g. “C:\Documents and Settings\UserName\

Application Data\Microsoft\Proof\CUSTOM.DIC”). If the user-specific Microsoft Office custom dictionary
is found, a reference to that dictionary is added to the list of spelling dictionaries.

MindManager stores maps at this default location:

C:\Documents and Settings\UserName\My Documents\My Maps

MindManager Components

The application installs a variety of configurable components, including:

= Library
= Dictionary
= Tutorials

User configuration files are also installed to help govern their behavior.

Library

The Library component consists of two sub-components: Images and the Template Organizer. These are
optional but highly recommended components.
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*» Images are a library of pictures used to help make maps more memorable.
= The Template Organizer contains a variety of map and web templates.

The library is not uninstalled if you uninstall the application; this content is preserved for users upgrading
to newer versions.

The default location for the Library is:

C:\Documents and Settings\<user name>\Local Settings\Application
Data\Mindjet\MindManager\14\Library\<language version>

You may wish to install the library to a different location. See the documentation for deploying with the
Installation Wizard (page 18) or from the command line (page 24) for instructions.

Dictionaries

The Dictionaries component contains spell check dictionaries available, including dictionaries for over 10
languages. When using the installer, you can choose which dictionaries to install. You can also control
dictionary installation from the command line.

Dictionaries are not removed during the uninstall process; this content is preserved for users upgrading to
newer versions of the application.

The default location for Dictionaries is:

C:\Documents and Settings\<user name>\Local Settings\Application
Data\Mindjet\MindManager\14\Spell

Tutorials
By default, all tutorials are installed. The default location for local tutorials is:
C:\Program Files\Mindjet\MindManager 14\<language version>
You can customize your tutorial installation by choosing:
= To deploy them to a server, rather than installing them on local machines
or

= To not deploy tutorials at all

User Configuration Files

MindManager creates and stores user configuration files for different purposes.

Table 2: Configuration Files

FILE NAME LOCATION AND FUNCTION

ImagePropertyDatabase.dat C:\Documents and Settings\<username>\Local
Settings\Application Data\Mindjet\
MindManager\14

The application runtime, not the installer, creates this file
dynamically. It collects information about keywords assigned
by the user to images.

UserData.ini C:\Documents and Settings\<username>\Local
Settings\Application Data\Mindjet\
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FILE NAME LOCATION AND FUNCTION
MindManager\14

This file detects the first time a user launches the application
and initiates procedures such as registry cleanup.

Library.ini C:\Documents and Settings\<username>\Local
Settings\Application
Data\Mindjet\ MindManager\14\Library\<language
version>

This file detects the library installation time. Because the
application installs the library the first time it is launched, this
file prevents multiple library installations.

Shortcuts and Start Menu Items

The installer puts a shortcut to the program on the Windows Desktop, the Windows Send To menu and in
the main Start menu. It creates a Mindjet folder in the Start >Programs folder with a shortcut to
MindManager in it.

The MindManager shortcut is an “advertised shortcut” to the program that automatically checks to
determine if the program needs to be repaired before it is run. If a repair is needed, it is performed then. If
you do not want to use this self-repairing feature, you can create a shortcut directly to the
MindManager.exe file instead. Deleting this copy of the installer disables the self-repair service as well.

Shared System Software

Some shared software must be installed on your system before using the admin setup. During
installation, MindManager uses merge modules to install other missing software, such as PIPanel.msm.
Missing components are installed from the modules. Depending on the host machine’s configuration, the
merge module installs the components required for that machine.

These shared components are not uninstalled automatically. Their default locations are indicated below.
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Table 3: Location of Shared System Components

Ink related files %CommonProgramFiles%\Microsoft Shared\Ink

InkObj.dlI
tpcps.dll
PIPanel.exe*
PIPanel.dll*
GdiPlus.dll

%WINDIR%\system32

= InkEd.dll
= PipRes.dIlI*
= wisptis.exe

* These components are installed only on Tablet PCs.

C++ runtime libraries %WINDIR%\system32
= msvcp60.dll
= msvcp80.dll

For a complete list of these merge modules’ components, see
Microsoft's documentation

Environment variable names (e.g. “%6CommonProgramFiles%”) are expanded to their actual values
(e.g. “C:\Programs Files\Common Files”) by the installer.

Third-Party Software

MindManager uses specific third-party software. Unless otherwise stated, the installer checks to learn if
the component is present on the system. If not, or if the application uses a newer version, the application
installs or updates the software. The setup process places third-party software at C:\Program
Files\Mindjet\MindManager 14\, and removes during the application uninstall process.

Table 4: Third-Party Software Overview

adfactry.dll = Active Delivery Factory is a self-extracting zip
executable
= Inner Media, Inc.

atl70.dll = Active Template Library, template-based C++ classes,
creates COM objects
=  Microsoft

BCGCBPRO2100u.dll = BCG Control Bar Professional DLL
BCGPStyle2010Black210.dll BCGSoft Ltd. Portions
BCGPStyle2010Blue210.dll

BCGPStyle2010White210.dll
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THIRD-PARTY SOFTWARE

Blowfish algorithm

ChartFX.ClientServer.core.dll

dunzip32.dll

dzip32.dIl

axinterop.officeviewermme.dll
interop.officeviewermme.dl|
officeviewermme.ocx

extensibility.dll

gdiplus.dll

HTS32MM.dII

Independentsoft.Webdav.dll

libtidyU.dll

interop.msscriptcontrol.dll
msscript.ocx

matrix.dll

Microsoft .NET Framework

Mfc80.dll

msvcp70.dil

DESCRIPTION AND VENDOR

128-hit encryption for password protection
Schneier Publishing

Chart FX Client Server ActiveX Control is used with
spread-sheets to create bar charts
Software FX, Inc.

DynaZIP-32 Multi-Threading UnZIP DLL
Inner Media, Inc.

DynaZIP-32 Multi-Threading ZIP DLL
Inner Media, Inc.

Base Office Viewer used by embedded Browser
EDrawSoft

Allows addition of add-ins
Microsoft

GDI+ is a C/C++ API that supports integrating graphics
and images on both the video display and printer
Microsoft

An HTML control that supports inserting pictures,
hyperlinks, tables, and other objects into RTF text
Sub Systems, Inc.

WebDAV protocol client API for .NET Framework
Independentsoft

HTML Tidy fixes a variety of HTML issues
WWW Consortium

Parses the XML returned by the Web Services
Microsoft

Map co-editing engine
AG Software

Microsoft Web Services Enhancements 4.0 for
Microsoft Windows Communication Foundation
Microsoft

Microsoft Foundation Classes, wrap Windows APIs in
C++ libraries, forming application framework

Other components are associated with this .dll. See
Microsoft's documentation for complete information.
Microsoft

Microsoft C++ Runtime Library
Microsoft
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THIRD-PARTY SOFTWARE
redemption.dll
Sax Basic Engine
ww10_000.chm
ww10 32w.dll
Sfxbe322.dll

Sfxfe32.exe

Spr32du70.dll

Ssceb532.dll

TER32MM.DLL

Vic32.dll

vsflex8n.ocx

zlib.dll
zlib64.dll

DESCRIPTION AND VENDOR
Supports Microsoft Outlook Integration
Components that enable VB-like scripting

Support WinWrapBasic from Polar Engineering

A 32-bit active delivery self-extracting, back-end zip
executable.
Inner Media, Inc.

A 32-bit active delivery self-extracting, front-end zip
executable.
Inner Media, Inc.

FarPoint Spreadsheet Control
FarPoint Technologies, Inc.

Spell checker engine
Wintertree Software, Inc.

RTF edit control
Sub Systems, Inc.

Image processor
Catenary Systems, Inc.

VSFlexGrid8 (Unicode) helps display, edit, and format
tabular data in spreadsheets. Helps integrate with
Microsoft Excel.

ComponentOne

Lossless data compression library
Jean-Loup Gailly and Mark Adler

ThirdPartyReadMe

See the link below for additional legal information regarding Mindjet’s use of third-party software:

http://www.mindjet.com/legal/thirdpartyreadme.

Registry Keys

The installer places any per-machine Mindjet registry settings in or below the key:
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14

These are the settings used by the application and its add-ins on a per-machine basis. No per-user
values are stored in this key.

Following Windows guidelines, the application registers its associated file types, COM objects, etc., in
sub-keys of HKEY_CLASSES_ROOT.

Table 5: Registry Key Overview

MindManager Large Scale Deployment Guide
Document Version 15.0
September 11, 2014 9

© 2014 Mindjet. All Rights Reserved


http://www.mindjet.com/legal/thirdpartyreadme

KEY TYPE LOCATION/KEY
HKEY_LOCAL_MACHINE HKEY_LOCAL_MACHINE\SOFTWARE\WMindjet\MindManager\14
HKEY_CLASSES ROOT HKEY_CLASSES ROOT\...(all keys below this level)

.mmap

.mmas

.mmat

.mmbas

.mmmp

.mmms

.mmp
Mindjet.MindManager.Custom.Document
Mindjet.MindManager.Document.x
Mindjet.MindManager.Document. Template.x
Mindjet.MindManager.Macro.x
Mindjet.MindManager.MapMarker.x
Mindjet.MindManager.MapMarkerSet.x
Mindjet.MindManager.MapPart.x
Mindjet.MindManager.Style.x

Mindjet. Mm5GenericSmartMapPart.AddIn
Mindjet. Mm5GenericSmartMapPart.AddIn.x
Mindjet. Mm5Sort.AddIn

Mindjet. Mm5Sort.AddIn.x

Mindjet. Mm5WebExportAddin

Mindjet. Mm5WebExportAddin.x
Mindjet. Mm10ExcelLinker.AddIn.x
Mindjet. Mm10ExcelLinker.AddIn
Mindjet. Mm10MsProject.AddIn

Mindjet. Mm10MsProject.AddIn.x
Mindjet. Mm100utlook.AddIn
Mindjet.Mm2100utlook.AddIn.x

Mindjet. Mm100utlookLinker.AddIn
Mindjet. Mm2100utlooklinker.AddIn.x
Mindjet. Mm10PPExport.AddIn

Mindjet. Mm10PPExport.AddIn.x
Mindjet.MmZ10Project.AddIn
Mindjet.Mm10Project.AddIn.x

Mindjet. Mm10Word.AddIn

Mindjet. Mm10Word.AddIn.x
MindManager.Application
MindManager.Application.x
MindManager.Color
MindManager.Color.x
MindManager.TextFont
MindManager.TextFont.x
Mm5WebExport.Page
Mm5WebExport.Page.x
Mm5WebExport.Pages
Mm5WebExport.Pages.x
Mm5WebExport.VariantSets
Mm5WebExport.VariantSets.x
Mm5WebExport.WebExport
Mm5WebExport.WebExport.x
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=  Mm5WebExport.WebExports
=  Mm5WebExport.WebExports.x
= MMS8InternetExplorer.BHO

=  MMB8InternetExplorer.BHO.x

Uninstall Key HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Curre
ntVersion\Uninstall

HKEY_CURRENT_USER HKEY_CURRENT_USER\Software\Mindjet\MindManager\14

Uninstall information for the program is stored in a sub-key of:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

The name of the sub-key is the Globally Unique Identifier (GUID) for the program (which changes with
each release). You can find it by using RegEdit to search for “MindManager” in the Uninstall key. The
uninstallation key does not remain after uninstalling.

When a user runs the application, any per-user registry settings are stored in or below the key:
HKEY_CURRENT_USER\Software\Mindjet\MindManager\14

Some Current User keys remain after uninstalling. These keys help preserve user data for upgrading to
the next version of MindManager.
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WHAT REMAINS AFTER
UNINSTALLATION

When you uninstall, almost all traces of the application are removed, including all components located at
C:\Program Files\Mindjet\MindManager 14 . Most registry keys are removed as well. Map files (.mmp
and .mmap files) are not deleted.

On Microsoft Windows 7 or any other system where the system administrator has disallowed the use of
RegEdit to export the registry key (i.e. DisableRegistryTools is set), the registry key is backed up to a
MindManager registry subkey under:

HKCU\Software\Mindjet\MindManager\MMX14RegistryBackup_<date>_<time>.

Some the remnants of the application are left behind. These are needed to preserve user data when
upgrading to a newer version. See Remaining Files, Folders, and Software Components (page 13) and
Remaining Registry keys (page 13) for more information.

Remaining Files, Folders, and Software Components

When you uninstall, the installer leaves behind some components it installed with the program. The tables
below reflect the most common remaining components and registry keys. The actual list may vary
depending upon the installation and deployment. In general, components left behind fit one of these
scenarios:

= User data (the library, images, and templates) remains to support upgrading to the next version or
= Shared components, such as C++ libraries, and their registry keys get left behind because they
may be required for other purposes

or

= A backup of your registry

Table 6: Remaining Files, Folders, and Software components

COMPONENT LOCATION AND EXPLANATION

C++ runtime libraries See Shared System Software (page 6) for locations.
These files may be in use by other applications.

Ink related files See Shared System Software (page 6) for locations.
These files may be in use by other applications.

MMX14RegistryBackup_<d  C:\MyDocuments\

ate>_<time> Opening thjs file gives you the option to add its contents to your

current registry.

msvcp60.dll %WINDIR%\system32
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This software may be in use by other applications.
msvecrt.dll %WINDIR%\system32

This software may be in use by other applications.
XML-related files See Shared System Software (page 6) for locations.

These files may be in use by other applications.

User Data C:\Documents and Settings\<local user>\Local
Settings\Application Data\Mindjet\MindManager\14

Contains dictionaries, images, templates dictionaries etc. that the
user may have customized. Does not uninstall so the user does not
lose this data when upgrading.

Remaining Registry Keys

Some registry keys remain after uninstallation. A backup copy of your registry is placed at:
C:\My Documents\MMX14RegistryBackup_<date>_<time>

Table 7: Remaining Registry Keys

HKEY_CLASSES ROOT HKEY_CLASSES ROOT\
= .mmap
= .mmp

These keys register . mmap file extensions.
HKEY_CURRENT_USER HKEY_CURRENT_USER\Software\Mindjet\MindManager\14\

Keys at or below this preserve user data for upgrading.
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USING THE ADMIN SETUP

The Admin setup gives systems administrators more control over an installation. It is distributed in a .zip
archive that contains the following files:

» MindManager Admin.msi

The MindManager Microsoft installer.

= dotNetFx40_Full_setup.exe

Microsoft's .NET Framework redistributable setup.

=  instmsi30.exe

Microsoft Windows Installer engine setup. (Normally already on the target system.)

=  msxml6_x86.msi
The MSXML 6.0 installer.

= vcredist_2005_spl x86.exe
= vcredist_ 2010 spl x86.exe
= vcredist_ 2010 _spl x64.exe

Microsoft Visual C++ run-time environments for versions 2005 and 2010 (including 2010 for 64-bit
machines.)

= MindManager _Large_Scale_Deployment_Guide.pdf
This Deployment Guide.

Using the admin setup gives you nearly complete control over your deployment, including:

= Deploying (or not deploying) specific components
= Disabling functions, such as internet access
= Storing components on network drives, such as user data or the library

You also have the option of configuring many items from the registry.
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Required Software

All required software is in included in the Admin setup package. It contains some software that must be
installed on your system before using the setup. You should verify that this software is already installed
on your system; if not, install it from the admin package.

= vcredist 2005 spl x86.exe installs the VC++ Redistributable components for Visual Studio
2005.

Check for existence of registry key:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
{7299052b-02a4-4627-81£f2-1818da5d550d}

Or simply re-install.

= vcredist_2010_spl_x86.exe installs the VC++ Redistributable components for Visual Studio
2010.

Check for existence of registry key:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
{FOC3E5D1-1ADE-321E-8167-68EFODE699A5}

Or simply re-install.

= vcredist_ 2010 _spl x64.exe installs the VC++ Redistributable 64-bit components for Visual
Studio 2010. Only for 64bit machines.

Check for existence of registry key:

HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
{1D8E6291-BOD5-35EC-8441-6616F567A0F7}

Or simply re-install.

=  msxml6_x86.msi installs the MSXML 6.0 SP1 Parser

Check the installed programs in the Control Panel to check existing installation.

= dotNetFx40_Full_setup.exe installs the Microsoft Net Framework

Check the installed programs in the Control Panel to check existing installation. This install can
take quite a long time.

Note: You should check for and install any missing components in the order listed above.

Required Permissions and Privileges

Administrator privileges are required to install any Windows software, including MindManager.
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No special privileges or disk permissions are required to run the application. A user can run the program
as a restricted user, a “normal” user, a power user, or an administrator. The program does assume that
the user has read/write/create privileges in the HKEY_CURRENT_USER registry key as well as in the
user profile section of the hard disk and below.

If a user does not have write privileges in the HKEY_LOCAL_MACHINE registry key, then:

The Help/Check for Updates command is removed for that user, ensuring that they will not try to
perform an upgrade that they are not authorized to do.

Differences between the Standard and Admin Setups

The Admin setup is based on the standard setup—with a number of important differences:

Caching: The admin setup does not cache the setup on the computer where it is being installed.
Instead, the setup should be run from a network location that remains accessible from the workstation
at all times. This ensures proper operation of the Modify, Repair, and Remove entries in the
“Add/Remove programs” Control Panel applet, and avoids duplication of the installation source on
every system where the application is installed.

Patching: Admin setups are only delivered as full setups, not patch setups. The reason for this is that
system administrators might modify the admin setup to suit the needs of their individual company. If
the installation database is transformed in this way, a future patch would not be able to properly
update the installation. We avoid this problem by not delivering patch updates at all for our admin
setups. To upgrade, you need to uninstall the previous version and install the upgrade.

Packaging: We exclude the Microsoft Windows Installer engine and .NET Framework installer. Both
components must be installed prior to running MindManager.msi if they are missing from a user’s
machine.

User Data: The admin setup includes the option to specify the location of user data.

Library Files: There is also an option to have the application extract the library files as usual, or to
have the administrator set this up “manually,” ahead of time. For more information, see Deploying
User Data and the Library to a Server, page 21.

Installing MindManager: An Overview

This section gives an overview of the admin setup and application components. With this information, you
can understand the installation process and determine what you may wish to customize for your
deployment.

Per-machine Setup

The setup installs the program on a client machine and only sets per-machine registry settings in the
HKEY_LOCAL_MACHINE and HKEY_CLASSES_ROOT registry keys. It does not directly create or set
any registry keys or values in the HKEY_CURRENT_USER registry key.

The installer installs all program files to this default folder:
C:\Program Files\Mindjet\MindManager 14

Administrator privileges are required to install any Windows software, including MindManager.

Per-user Setup
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Each time the application launches, it checks the UserData.ini file, located in C:\Documents and
Settings\<Username>\Local Settings\Application Data\Mindjet\MindManager\14 to determine if a
per-user setup needs to be performed.

If this file is missing, or if the version of the application installed is newer than the version the user last
ran, then MindManager prepares for a “new” per-user installation by deleting the following registry key:

HKEY_CURRENT_USER\Software\Mindjet\MindManager\14\User Interface

The application also determines if the per-user application data files (outline print templates and spell
check auto-correct dictionaries) are present. If not, it copies them from the “All Users” folder:

C:\Documents and Settings\All Users\Application Data\Mindjet\MindManager\14

Finally, the application determines if the per-user Library files need to be installed using the same
UserData.ini algorithm described above and checks the LSDLibraryExtract. If the registry is not set to O,
then a separate background task/program is run to unzip the library files from a MindManager sub-folder:

C:\Program Files\Mindjet\MindManager 14\sys\<language version>

The Vista system folder structure uses environmental variables instead of real paths. Note the different
path structure below:

%USERPROFILE%\Local Setting\Application Data\Mindjet\MindManager\14
%ALLUSERPROFILE%\Application Data\Mindjet\MindManager\14

%ProgramFiles%\Mindjet\MindManager 14\sys\<language version>
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DEPLOYING WITH THE
INSTALLATION WIZARD

Using the admin setup to install the application is straightforward and simple. Unlike the basic setup, you
have customization options, though not as many as from the command line.

Starting the Installation

To install the application:

1. Launch the installer.

2. Atthe welcome screen, click Next.

3. Select “| agree to the terms of the license agreement” and click Next.
4. Enter the Customer Information (User Name and Organization).
5

Click Next.

The Setup Type dialog appears.

ﬁ Mindjet Mindkanager Setup @

fl mindjat

Setup Type

MindManager

Please select a sektup bype,

@ Standard

&l program features will be installed,
Recommended For most users,

Choose which program features wou want installed and where they
will be installed,

Installshield

< Back ][ Mext = ] [ Cancel
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At this point, you can customize your deployment or complete the installation (page 23).

Customizing the Installation

A custom installation allows you to:

= Disable default features
= Change the default installation folder
= Deploy user data and the library on a separate server

If you need to customize the installation beyond these parameters, see Deploying from the Command
Line (page 24).

Disabling Default Features

To disable the default installation features:
6. Complete steps 1-5 in Starting the Installation (page 18).
7. Select Custom and click Next.
The Custom Setup dialog appears.

8. Inthe tree, select a feature whose default installation you want to change.

9. Click the down arrow button = .

10. Select the desired feature setting.
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Zuskom Setup

§ mindjet

Click. on an icon in the list below to change how a Feature is installed,

Feature Description
The R55 Feeds allows wou ko display
R35 feeds in MindManager.

FSS Feeds

=8 This feature will be installed on local hard drive,

¥ This feature will not be available.

Inskall ko

Inskallshield

j{{'}l Mindjet Mindbdanager Setup @

MindManager

=18 This feature, and all subfeatures, will be installed an local hard drive,

C\Program Files (x86)1MindjetiMindrManager 14

Help ] [ Space ] [ < Back ] [ Mexk = ] [ Zancel

For each selected feature, a description and storage requirement appears.
11. Repeat this process until you have made all of your feature customization choices.

12. Complete the installation as outlined in Completing the Installation (page 23).

Changing the Default Installation Folder
To change the default installation folder:

13. Complete steps 1-5 in Starting the Installation (page 18).
14. Select Custom and click Next.

The Custom Setup dialog appears.
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o

ﬁ'}‘ bindjet Mindbdanager Setup

Zuskam Setup ] mindjet

MindManager

Click an an icon in the lisk below ta change how a Feature is installed.

- Feature Description
& _Q;I MlndMan._ager ) The B35 Feeds allows vou to display
[+ =3 » | Microsoft Add-ins 35 feeds in MindManager,

- =l = | Dickionaries

- RS5 Feeds

This Feature requires 61KB on your
hiard drive.

Install ka:
Ci\Program Files (x86)MindjetiMindManager 144,

Help ] [ Space ] [ < Back ] [ Mext = ] [ Cancel ]

Inskallshield

15. Click Change.

The Change Current Destination Folder dialog appears.

16. Select the destination folder.

17. Click OK.

The new destination folder appears in the Custom Setup dialog.

18. Complete the installation as outlined in Completing the Installation (page 23).

Deploying User Data and the Library to a Server
MindManager installs a “Library” folder containing:

= Background Images

= |cons

= Images

= Map Parts
= Shapes

= Styles

= Templates
=  Web Export Templates

The entire library consists of several megabytes. By default, these files are stored on a per-user basis in
this folder:
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C:\Documents and Settings\UserName\Local Settings\Application
Data\Mindjet\MindManager\14\Library\<language version>

where UserName is the current user's logon name.
You can store user data and the library in a network folder for if you wish to:

= Save space on users' systems

= Decrease the time required to run the program the first time

= Allow roaming user’s access to their customized libraries

= Assure that all users have a fixed, easily updatable set of library files

You can install these files once to a common location (perhaps in a read-only folder). Multiple users can
then share the files, or a single user can access them from multiple machines. If a user needs to edit
these files, install them in a directory with write privileges.

You cannot install user data and the library to separate locations from the installation wizard. To install
them separately, you must install them from the command line (page 24).

To deploy user data and the library to a server:
19. Complete steps 1-5 in Starting the Installation (page 18).
20. From the Custom Setup dialog, click Advanced.
The Deploy User Data Files dialog appears.

21. Select Deploy user data on server.

ﬁ Mindjet MindManager Setup @

Deploy user data files ] mindjet

MindManager

@ Install user data files on local disk

This is the recommended method for standard inskallations, User data files are installed inko
the standard Windows per-user data location,

(") Deploy user data on server

IJse this method to store all user data files in a central server folder, Please make sure wou
have read the large scale deployment installation document wvou can download From khe
Mindjet website,

Server base path;

Erowse, ..,

Exkract library to the server path the firsk time MindManager skarks

Ise separate folders per user
Presvigwm Path

Installshield
Ck, ] [ Cancel
22. Click Browse.
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The Browse for Folder dialog appears.

23. Select the destination folder.

24. Click OK.

The new directory appears in the Server base path field.
25. Choose from the following options:

= Extract library to the server path the first time the application starts
= Use separate folders per user

We recommend selecting both of these options to avoid needing to configure the user data folder and the
library folder separately. You may want to create the user folders before installation, giving you the
chance to make the files read only.

26. Click OK to close the dialog.
27. Complete the installation as outlined in Completing the Installation (page 23).

These are all of the customization choices available from the installer interface. You have more control if
you deploy from the command line (page 24).

Completing the Installation

To complete the standard installation:
28. Select Complete and click Next.
The Ready to Install dialog appears.
29. Choose your shortcut options.
30. Click Install.
31. After the installation is complete, choose from the following options:

= Launch MindManager
= Register MindManager

32. Click Finish.
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DEPLOYING FROM THE COMMAND
LINE

While you may wish to customize your deployment from the installer interface (page 19), you have much
greater control over the installation from the command line, including:

Configuring installation parameters (page 24)

Specifying what to install on a feature by feature basis (page 25)
Enabling or disabling program functions

Specifying where to install libraries, and user data (page 30)
Using a custom SharePoint SiteConnections.xml file (page 49) *

* To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise.

This section identifies what you may configure and provides examples of command line arguments for
customizing your deployment. A sample installation command demonstrating most of these options is
included in Sample Setup Commands (page 32).

Configuring Installation Parameters from the Command Line

You can set a number of public properties with command line options.

Table 8: Configuring Installation Parameters from the Command Line

PARAMETER DESCRIPTION OF VALUES

INSTALLDIR Specifies where the application should install the program. For
example:

"C:\Program Files\Mindjet\MindManager 14\"

ISX_SERIALNUM Specifies the license key for your installation. Note: No validation is
performed for this key, it is simply written to the registry. If the license
key is not valid, the application runs in a restricted (trial) mode.

USERNAME Specifies the User Name for registering the application.

Optional parameter; the Windows User Name will be used if this
parameter is not supplied.

COMPANYNAME Specifies the Company Name for registering the application.

Optional parameter; the Windows Company Name will be used if this
parameter is not supplied.
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Configuring Features from the Command Line
The admin setup is a Basic MSI project, not an InstallScript project; there is no record mode to run an
install with Setup.iss. Basic MSI projects do not create or use a response file for silent installations.

Tip: When configuring features from the command line, it is better to use /s silent installation to avoid
conflicts with properties set through the installer interface. You can remove or add features from the
command line by using ADDLOCAL or REMOVE on a feature by feature basis. To simplify the process,
use ADDLOCAL="ALL" and then remove features you do not want. Examples are provided below.

Customizing the Installation with Setup.exe
You can use the following options to add or remove features from the command line setup.exe:
/v=command line access to msi file
/qn=when used with /v parameter, silent (no user interface) parameter passed to msi file
Here are examples of adding and removing features through the setup.exe file, using silent install:
Adding:
<directory>\setup.exe /v"ADDLOCAL=\"MSWordAddin\" /gn"
Removing:
<directory>\setup.exe /v"ADDLOCAL=\"ALL\" "REMOVE=\"MSWordAddin\" /qn*"
You can also string together multiple features for inclusion or removal:
<directory>\setup.exe
/v"ADDLOCAL=\"AIN" REMOVE=\"MSWordAddin,PDFWriter,RSS\" /gn"

Customizing the Installation with MSI
You can use these options to add or remove features from the command line with MSl.exe:
f/i=install mode

/qn=silent (no user interface) parameter (Tip: /gn+ will let you know when it’s done)

Note: On a VISTA system, security features require that you run silent install (/qn) as the Administrator,
not as a member of the Administrator group.

Here are examples of adding and removing features through the msiexec.exe file, using silent install:
Adding:
msiexec /i "<directory>\filename.msi" ADDLOCAL="MSWordAddin" /gn
Removing:
msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="MSWordAddin" /gn

You can also string together multiple features for inclusion or removal:
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msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="MSWordAddin,PDFWriter,RSS" /gn

Table 9: Configuring Features with MSI from the Command Line

Library Available add-ins

The default add-in is Library, which installs add-ins below. You can
also specify a subset.

Images

Shapes
Backgroundimages
Icons
ImageGallery

Icons
TemplateOrganizer
Templates
WebTemplates
Styles

MapParts

Markers

Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="WebTemplates" /gn

Dictionaries Available add-ins

The default add-in is Dictionaries, which installs add-ins below. You
can also specify a subset.

Swedish

Spanish
NorwegianB
BrazilianPortugese
Italian

Danish

Finnish
CanadianEnglish
USEnglish
UKEnglish
French

Dutch

German

Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="CanadianEnglish" /gn

Microsoft Add-Ins Available add-ins

The MSAddins feature is a container for the following Microsoft-related
add-ins. Any or all of these sub-features can be all installed by
specifying them on the command line. (Examples below clarify this.)
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FEATURE COMMENTS
MSWordAddin
MSOutlookLinkerAddin
MSOutlookMapMinderLinkerAddin
MSPowerPointAddin
MSProjectAddin
MSExcelLinkerAddin
MSIEAddin
Note:

This MSAddins feature, and all sub-features, can be removed with
REMOVE=“MSAddins” but they cannot be added with
ADDLOCAL=“MSAddins.”

Example:

There are three options for including a feature that's not installed:
1. Include the selected feature
2. Include the selected feature and all sub-features

3. Include the selected feature and then select sub-features
individually

= Using ADDLOCAL="MSAddins" is equivalent to (1)
above. However, this causes no add-ins to be added since
MSAddins is just a container for other add-ins, and they
need to be specified.

= ADDLOCAL="MSAddins, MSExcelLinkerAddin,
MSIEAddin, MSOutlookLinkerAddin,
MSPowerPointAddin, MSProjectAddin,
MSWordAddin" is equivalent to (2) above.

= Using a subset of MSIEAddin, MSOutlookLinkerAddin,
MSPowerPointAddin, MSProjectAddin, MSWordAddin is
equivalent to (3) above.

RSS The add-in is RSS
Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="RSS" /gn

Configuring Functions from the Command Line

During installation, you can disable some functions by setting the value to “0.” For example:

msiexec /i "<directory>\Mindjet Admin.msi" /qn ONLINEHELP="0"
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Table 10: Configuring Functions from the Command Line

Macro Support The function name is MACROUI.

Example (msi):

msiexec /i "<directory>\MindjetAdmin.msi" /gn MACROUI="0"
Shortcuts The function names are:

= SHORTCUTDESKTOP
= SHORTCUTSTARTMENU
= SHORTCUTQUICKLAUNCH

Example:

msiexec /i "<directory>\Mindjet Admin.msi" /gn
SHORTCUTSTARTMENU="0"

Internet Access The function name is INTERNETACCESS.
Example (msi):

msiexec /i "<directory>\Mindjet Admin.msi" /gn
INTERNETACCESS="0"

Example (setup.exe):
<directory>\setup.exe /s V" INTERNETACCESS=0 /gn"
Online Help The function name is ONLINEHELP.
Example (msi):
msiexec /i "<directory>\Mindjet Admin.msi" /qgn ONLINEHELP="0"
Example (setup.exe):
<directory>\setup.exe /s /v"ONLINEHELP=0 /gn"
Ul Customization The function name is UICUSTOMIZATION.
Example (msi):

msiexec /i "<directory>\Mindjet Admin.msi" /gn
UICUSTOMIZATION="1"

Example (setup.exe):

<directory>\setup.exe /s /v"UICUSTOMIZATION=1 /gn"
Disable Attachments The function name is DISABLEATTACHMENTS

Example (msi):

msiexec.exe /i "Mindjet Admin.msi" DISABLEATTACHMENTS=1
/gqn

MindManager Large Scale Deployment Guide © 2014 Mindjet. All Rights Reserved
Document Version 15.0
September 11, 2014 28



Configuring Functions from the Registry

The application supports configuring specific functionality in the registry before installing the application.
The installer reads these keys and retains these settings. After installation is complete, you can hand-
configure these settings as well. To disable a function, set the registry value to “0.” Reset the value to “1”
to re-enable the function. Each key is of the type REG_DWORD.

Table 11: Configuring Functions from the Registry

FUNCTIONS
Macro Support

Internet Access

Online Help

Ul Customization

Catalyst Access

Connect Access

Disable Attachments

EXAMPLES
The registry key is MacroUiEnabled.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Setti
ngs "MacroUiEnabled" (0)

The registry key is InternetConnectionEnabled.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Setti
ngs "InternetConnectionEnabled" (0)

The registry key is OnlineHelpEnabled.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Setti
ngs "OnlineHelpEnabled" (1)

The registry key is EnableUserCustomization.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Setti
ngs "EnableUserCustomization" (1)

The registry key is ConnectEnabled.
Example:

HKEY_LOCAL_MACHINE\SOFTWAREWMindjet\MindManager\14\Se
ttings "ConnectEnabled" (0)

Note: Catalyst is turned off by default in version 10.0
The registry key is Connect3Enabled.
Example:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Se
ttings "Connect3Enabled" (1)

Note: Connect is turned on by default in version 10.0, and this key
must be entered manually.

The registry key is DisableAttachments.
Example:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Setti
ngs "DisableAttachments" (1)
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Effort The registry key is ShowEffort.
Example:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Se
ttings\ShowEffort

Note: Set dword to either 0 or 1 during an LSD (or setup.exe)
installation.

License Key The registry key is License Key.
Example:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\R
egistration

Note: Use .reg script to set the key via ISX_SERIALNUM deployment.

Online Files The registry key is Connect3ApiEnabled

Example:

HKEY_CURRENT_USER\Software\Mindjet\MindManager\14\Settin
gs\Connect3ApiEnabled

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Mindjet\Min
dManager\14\Settings\Connect3ApiEnabled

Note: Adds ‘Let add-ins use online features’ checkbox to Add-Ins
tab of Options dialog.

Deploying User Data and the Library

As discussed previously in Deploying User Data and the Library to a Server (page 21), you may want to
deploy user data and the library to a server. If you want to deploy the user data and library on separate
servers, you must do so from the command line or by editing the registry.

Deploying User Data and the Library from the Command Line

The following commands give you the ability to deploy user data and the Library to separate locations.
Each option consists of a property, which (when given a command line value) writes to the registry. You
can also predefine these options by creating and executing a registry script before a silent setup.

Table 12: User Data Deployment Options

USERDATAPATH="<user HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\|
specified path>" nstaller "LSDUserDataPath" "<user specified path>"
USERDATAPERUSERPATH=  Deploy user data in a per-user folder.

1 1=Enable

O=Default or disable
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HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\|
nstaller "LSDUserDataPerUser" (1)

USERDATAPATHSUFFIX="<  This folder is appended to the per-user folder.

user specified path> HKEY LOCAL_MACHINE\Software\Mindjet\MindManager\14\I
nstaller "LSDUserDataPathSuffix" "<user specified
directory>"

Example:

msiexec /i "Mindjet Admin.msi" USERDATAPATH="C:\Temp\UserData"
USERDATAPERUSERPATH="1" USERDATAPATHSUFFIX="MyUserData"

Table 13: Library Deployment Options

LIBRARIESPATH="<user HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\|
specified path>" nstaller "LSDLibraryPath" "<user specified path>"
LIBRARIESPERUSERPATH=  Deploy libraries in a per-user folder.
v 1=Enable

O=Disable

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\|
nstaller "LSDLibraryPerUser" (1)

LIBRARIESPATHSUFFIX="<u This folder is appended to the per-user folder.

ser specified directory> HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\
nstaller "LSDLibraryPathSuffix" "<user specified directory>"

LIBRARIESEXTRACT="1" Extract libraries to path the first time the application starts.
1=Enable
O=Disable

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\|
nstaller "LSDLibraryExtract" (1)

Example:

msiexec /i "Mindjet Admin.msi" LIBRARIESPATH ="C:\Temp\Libraries"
LIBRARIESPERUSERPATH ="1" LIBRARIESPATHSUFFIX ="MyLibraries"
LIBRARIESEXTRACT="1"

Deploying User Data from the Registry

During a silent (non-interactive) installation, you can deploy data user files by setting some registry values
on the user's system in the registry key before running the installer:

HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Installer
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Table 14: User Data Registry Key Values

REGISTRY VALUE DATA VALUE
LSDUserDataPath Examples:
N:\User Data\All Users\Mindjet\MindManager\
or

N:\User Data (if LSDUserDataPerUser is set to 1)
LSDUserDataPerUser 0 = Do not use separate folders per user

1 = Do use separate folders per user
LSDUserDataPathSuffix See above

Example:

Mindjet\MindManager\14

Only applies if LSDUserDataPerUser is set to 1

If you want to deploy all of the user data (including the library) on a server, create a registry file named
“‘MindManager Large-Scale Deployment Options.reg” like this:

REGEDIT4

[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager]
[HKEY_LOCAL_MACHINE\SOFTWAREMindjet\MindManager\14]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Installer]
"LSDUserDataPath”="N:\\User Data\\All Users\\Mindjet\\MindManager 14"
"LSDUserDataPerUser"=dword:00000001
"LSDUserDataPathSuffix"="User Data"

LSDLibraryPath= N:\\All Users\\Mindjet\\MindManager 14
"LSDLibraryPerUser"=dword:00000001
"LSDLibraryPathSuffix"="Library"

"LSDLibraryExtract"=dword:0000001

Sample Setup Commands

The following sections provide sample commands to demonstrate various installation scenarios.

Simple Installation
This command simply runs the installer in the usual interactive mode.
Msiexec.exe /i "Mindjet Admin.msi"

You can also run MindManager Admin.msi from Windows Explorer.
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Silent Installation
This command silently runs the installer, supplying values for all required parameters.

Msiexec.exe /i " MindManager Admin.msi" /qn INSTALLDIR="C:\Program
Files\Mindjet\MindManager 14\" ISX_SERIALNUM="MPXM-MMZI1-XXXX-XXXX-XXXX"

Note that the "XXXX-XXX-XXXX-XXXX-XXXX" portion of the license key must be replaced with a valid key.
Optional parameters are USERNAME and COMPANYNAME.

Sample Customized Installation Using ADDLOCAL and REMOVE
Here is an example for a customized silent install, using ADDLOCAL and REMOVE:

Msiexec.exe /i "Mindjet Admin.msi" /gqn /L*v "C:\MM14AdminSetup.log"
INSTALLDIR="D:\Program Files\Mindjet\MindManager 14\" ISX_SERIALNUM="MPxM-MM1-
XXXX-XXXX-XXXX" USERNAME="John Doe" COMPANYNAME="Acme, Inc."
ADDLOCAL="ALL" REMOVE=" MMPlayerExport, MSWordAddin" MACROUI="0"
INTERNETACCESS="0" UICUSTOMIZATION="0" ONLINEHELP="0"

Silent install options for the MMPlayerExport key that supports the Viewer feature are available and
supported using Admin .MSI package.

To remove the feature:

msiexec /i PATH_TO.msi ADDLOCAL="ALL" REMOVE="MMPIlayerExport" /qn\
To re-instate the feature:

msiexec /i PATH_TO.msi ADDLOCAL="MMPlayerExport" /gn

Uninstallation
This command uninstalls the application:

Msiexec.exe /x " MindManager Admin.msi"
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DEPLOYING WITH ACTIVE

DIRECTORY

Deploying via Active Directory and Group policies is has limited supported at this time because:

= The setup only supports computer-based software installation
= Some properties can only be configured from the command line

You can use configuration tools such as Orca to:

= Configure properties from the property table

= Save the settings to a transform file (MST)

= Deploy it with the updated values

Here is a list of properties you can modify in the Property Table:

Table 15: Properties Editable in Properties Table

PROPERTY
INTERNETACCESS=1/0

ISX_SERIALNUM

LIBRARIESPATH=<defaultpath>

LIBRARIESPATHSUFFIX=<defaultpath>
LIBRARIESPERUSERPATH=0/1

LIBRARIESEXTRACT=1/0

USERDATAPATH=<defaultpath>
USERDATAPATHSUFFIX=<defaultpath>
USERDATAPERUSERPATH=0/1

MACROUI=1/0

ONLINEHELP=1/0

REBOOTISREQUIRED=No/Yes

TOPICALERTSLINKER=1/0

DESCRIPTION/DEFAULT SETTING

= Allow internet access
= Default=1

Specifies a license key to activate the product. Add to
the properties table in the .mst file with the license key
as the value.

User can override default path.
User can override default path.

= Deploy libraries per user
= Default=0

=  Extracts libraries at first launch
= Default=1

User can override default path.
User can override default path.

= User Data deployed per user
= Default=1

= Enable Macros in Ul
= Default=1

= Enable online help
= Default=1

= Require reboot after installation
= Default=No

= Enable topic alerts linker
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= Default=1
UICUSTOMIZATION=1/0 (default=1) = Enable Ul customization

= Default=1
SHORTCUTDESKTOP=1/0 (default=1) = Create Desktop shortcut

= Default=1
SHORTCUTQUICKLAUNCH=1/0 = Create QuickLaunch shortcut

= Default=1
SHORTCUTSTARTMENU=1/0 = Create StartMenu shortcut
(default=1) = Default=1

Recommendations include

=  Saving these settings to the transform file as a backup, rather than directly to the MSI

= Deploying on a per-machine basis only, avoiding the possibility that the machines with multiple
users get multiple copies of the application installed

= Creating a policy for “Always install elevated,” otherwise the installation may fail
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DEPLOYING WITH WINDOWS
SERVER

You can install with Windows Server 2003 running Terminal Services, and then deploy it to variety of
client machines.

To install on a Windows Server 2003 running Windows Terminal Services (WTS):
1. Log on to the Windows Terminal Server as an administrator.
2. Launch Admin.msi.
3. We recommend using the Add/Remove Programs applet in the Windows Control Panel.
4

Avoid running the installer directly from Windows Explorer unless you are familiar with using the
“change user /install” and “change user /execute” commands.

5. Select Add New Programs and then select CD.
The automatic procedure does not find the setup program.
6. For the Run Installation Program dialog, click Browse.
In the Browse dialog:
7. Change Files of type to Programs.
8. Navigate to the installer location.
9. Select Admin.msi.
10. Click Open and then Next to start the installer.
11. In the Customer Information dialog, leave the User Name blank or chose a “generic” name.
The user can customize this by entering an Organization name and the License Key.
12. In the Setup Type dialog, choose Complete or Custom as desired.
For details about customization, see Deploying with the Installation Wizard (page 18).
13. Complete the installation as outlined in Completing the Installation (page 23).

14. Please make sure to finish the Admin Install wizard of the Windows Terminal Server by clicking
the Finish or Cancel button. Note: DO NOT START THE APPLICATION BEFORE THIS
DIALOG IS FINISHED!

You can now run on the server with the Windows Remote Desktop Connection client.

The application runs in full color mode and does not support 256-color mode. For best results, run the
terminal server clients in full color mode as well. Deploying under Windows 2000 server will function, but
with less than optimal results.
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DEPLOYING WITH CITRIX
PRESENTATION SERVER

The Citrix MetaFrame Presentation Server is a sophisticated terminal server environment built on top of
the Windows Terminal Services provided by Windows Server. This is currently the only tested and
supported Citrix platform, though other combinations may also behave properly.

Basic Installation for the Citrix Desktop

For better Citrix performance, do not install the application on a C: drive. After installation, MindManager
appears as part of the Citrix Desktop—a single window containing icons for all the published applications.

Advanced Installation of a “Seamless” Window

You can also install to Citrix as a seamless individual application window, instead of installing as part of
the Citrix desktop, as described above.

To install as a seamless individual application window:

1. Install on a Windows Server 2003 running Windows Terminal Services (WTS)

]
2. Click the Presentation Server Console button E‘ from the Citrix toolbar.

3. Log on to the server.

','i Log On to Server Farm

Enter the name of a server that iz in the farm to wwhich youw swarnt 1o cohnect.

Citrix MetaFrame Presentation Server: }'njtes‘ttﬂ LI

Erter your MetaFrame Administrator credentizls.

Lzt Matme: Iadministrator

FEEFEETLN
Passzword: I

Ciormain: Imj‘testl

Ok | Cancel Help

4. Inthe tree, select Applications.
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anagement Console for MetaFrame Presentation Server 3.0 - MINDJET !lil -

fctions  View  Help

@4 Qg s e B

E- MINDIET Caortents | Content Redirection | Resource Manager
B3 Applications

Zitrix Deskbo
B | MetaFrame Administrators E r
ﬁ Installation Manager &J Explarer

A8 Load Evaluators S/ MOTEPAD

g Policies WORD

Lg# Printer Management
] resource Manager
8] Servers

4 tems

5. Right-click Applications.
6. Select Publish Applications. (The Application Publishing Wizard appears).

Publish Application

Welcome to the Application Publishing Wizard

This wizard will help you publish an pplication

Enter information in the boxes below to identify the published application. Enter the name and
dieseription that you wart 1o be displayed to Clisnts

e . Display Mame:
CiTRIX ==

Application Description

The coolest program in the world]

Click Nest to cortinue.

After publishing an application, you can change its settings by selecting the published application and

_ choosing Properies inthe Presertation Server Console.

Mest [~ Cancel Help

7. Specify what to publish.

Publish Application - MindManager

Specify What to Publish

pplicetion Typs
& application
1 Deskop

 Contert

CITRIX'
0
This application typs grants users aceess to & singls applisation installsd on your servers

Erter the command line for the application you wart to publish. You can slso specify a defaul
working directary for users.

Cornmand Line:

[ pragram Fieswindieteinavanager swindvenager exe”

Browse.
L —

[cProgram Fieswindjetwinamanager 5

o Al s puilished resource o be accessed externaly through WeteFrame Secure Access
Manager

= Back | Next ™ | Cancel Help
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8. Define the Program Neighborhood Settings.

Program Neighborhood Settings

These settings control application launching in Program Neighborhoad. Vou can specify a folder to
contain the applisation's icon, and push appiisation shortouts to Start menus and deskdops of clients.

Program Neighborhood Folder

CiTRIX

pl Shortout

[ Ak to1he Clint's Start Meru

T~ Place i Frograms folder (Program Nelghborhood Agent orly)
Start Menu Foldsr (Program Nelghborhood Agent oriy):

[¥ Add shartout to the client's desktop

Icon: Ce Change lean...

~ Back | mext I Cancal Heip

9. Define the Application Appearance options. (Set to High Color or True Color).

Specify Application Appearance

These settings control the application appearance in ICA, sessions. Select the windowr size, nurmber af
colors, and startup setfings.

Session Windowr Size:

- [Percent of client deskion. =]
CiTRIX =T
Colore:

olor (16 bit)

ppl Startup

I Hide application tite ker

I Maximize spplication at startup

I Mote: Startup settings sre ignored in sesmiess mode ICA sessions

~ pack | west I~ Cancel Heip

10. Specify special client requirements. (Default settings are fine).

Publish Application - MindManager

Specify Client Requirements

Specify the defaut settings: for the application when users: connect with Frogram Neighborhood

¥ Eneble lgacy audia

T Minituen recuirement

Note: These auedio settings do not apply to SpeedScreen Mukimedia Acceleration

I~ Enable SSL. and TLS prtocols
& Inportant: There i no minimurm recuirement for this option. The settings onthe client device can
override this option.

g
=

I Wi gecparement

Printing;

¥ Start this spplication without wating for printers to be created

< Back | Next [~ Cancel Help
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11. Specify the number of licenses you have purchased in the “Maximum instances” field.

[Publish Application - MindManager

CiTRIX'

Specify Application Limits

These setlings control the number of instances and GPU griorty for the published apaication

Concurrent

[¥ Limit instances allowed to run in server farm

Meximum instanees: 15

I~ sllow only one instance of appiication for each user

CPU priority levet
]

- Back | Next I~ | Cancel Help

12. Specify which servers will deploy.

[Publish Application - MindManager

CiTRIX'

Specify Servers

Chaosethe servers on which this published spplication will un.
To choose = server, select f from the Availshle Servers list and elick Add.

Click Fiter Servers By ta fiter your view of the available servers.

It the application's configuration is nct identical on all servers, you can customize the configuration for
each server. Select the server from the Configured Servers list, then cick Edit Configurtion

fdd| [
Addd &1l 1

ayalable Servers: Configured Servers:

MITESTON

- Remove
“* Remave Al

et
Fiter Servers By |

Refresh Available Servers

Ecit Configuration |

- Back | Mext [~ | Cancel | Help |

13. Specify users. (We recommend

doing this by group, to ease the load of adding single users).

jon - MindManager

CiTRIX

Specify Users

Ta permit users ta run the published application, select thelr aeceunts from each account authorty and
click Addl. To prohibit users from running the spplication, select accounts from the Configured
Acoounts list ahd ok Rerroye,

I” Allow Anonymous Connections

Add List of Names

Look i

|0 MuTEST USERS

€ Don Souza

lgor Shirokow

Jnchen van der Mughlen
€ Larry Daniele

Michael Zaydman

7 Add £ Remowe

Configured Accourts

€7 MUTESTicrix

Ll

¥ show users

1 ftem

= Back | Next [~ Cancel Help
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14. Leave the File Type Associations page empty; the application is registered on the server.

Publish Application - MindManager

Specify File Type Associations

Select the file types you wart to associste withhis application for Client fo Server Cantert Redirection
NOTE: A file type can have multiple fie extenssions . When you sslect one checkbox for  file type, all
extensions far that fie type are selected.

Cliek Firish to complets the publishing wizard.

PNy | Mo T

* Mo File Type Associations are available Tor this application

Select Al

= i [e= ] =

Once you have completed the installation, you should see the MindManager in the Applications section:

}.: Management Console for MetaFrame Presentation Server 3.0... [Ej[=]
Actions  Wiew  Help

@4 b Qs EE R s G
B el @B ~HE + & X |0 &F

Users | Resource Managerl

¢ User |v| Server |v| C

L NOTEPAD
ﬂ MetaFrame Administrators
ﬁ Installation Manager

4.0 Load Evaluators

Palicies

4# Prinker Management

_iliﬁ Resource Manager

@] Servers

1| | »

The application icon now appears in authorized users' Citrix 3.x Program Neighborhood or in XenApp

F.] Citrix Program Neighborhood - MINDIET M=] E3
File %iew Tools Help

@‘XHE

Up Refresh Delete  Propetties  Sekking

=R

Citrize Deskbop  MindManager  MOTEPAD

|3 objectis)
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1 i = ] I = DI ¢ |
@ Cikrix Delivery Services Console

Alerts % xEnApp

[2] search
Iy Yiews
= [ Citrix Resources Information |C0ntent5| Blerts |
B > Configuration Tools
"< Hotfix: Management

Citrix ¥endpp is a Windows application delivery svste
applications in the datacenter and delivers them as a
ko users arvwhere using any device. ¥XenApp reduce
application management by up to 50 percent, increas
responsiveness when delivering an application to dist
improves application and data security,

& Administrators
= E‘ Applications

@ Firefox
B 14

MILL 1
MM 10 dok 2
2] Mokepad

@4 outlook 2010
[P Project 2010

i YLC
3 Hiskory
[runi -

Discovery was last run For this Citrix produck on: 10/29/2013 4:03 PM
Irnnnlnumnnf =tatns

For more configuration options, please consult your Citrix documentation.
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ADMINISTERING MINDMANAGER

There are other administrative issues involved in deploying on a large scale. You can address many of
them using the administrative tools and methods described below.

Managing Add-Ins

The application uses a number of add-in DLLs. The Add-Ins are automatically registered when the
application is installed. On startup, the Add-Ins check for any other required resources (e.g. the supported
version(s) of Microsoft Word). They enable or disable themselves as appropriate. If an add-in fails to start,
it is automatically removed from the list of add-ins (but not from the disk).

Registering or Unregistering Add-Ins from the Command Line
To unregister the Word add-in:
1. Select Start>Run.
2. Enter the command:
regsvr32 /u "C:\Program Files\Mindjet\MindManager 14\Mm10Word.dIl"
To restore an unregistered add-in, for example the Word Add-in,
4. Select Start>Run.
Enter the command:
regsvr32 "C:\Program Files\Mindjet\MindManager 14\Mm10Word.dll"

Managing Add-Ins from the Registry

Users can enable and disable Add-ins via the Tools > Add-Ins command. However, if desired it is
possible to disable or remove individual add-ins via the Windows Registry.

The Registry Add-In List

The list of add-ins that load at startup can be found in the Registry at:
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\AddIns

Removing or Restoring Add-Ins from the Registry

To remove an add-in (i.e. make it “invisible” to the application), delete its registry subkey.

To remove the Word add-in, delete the following key:
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HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\AddIns\Mindjet.Mm14Word
AddIn.x

This makes the add-in “invisible” to the application so it will not be loaded on program startup and will not
be seen in the list of add-ins in the Tools -> Add-Ins dialog. However, the add-in DLL files still exist on
the hard drive.

Another way to remove an add-in is to unregister it as described in Registering or Unregistering Add-Ins
from the Command Line (page 43). We do not recommend deleting the add-ins DLLs since they will be
restored automatically the next time the program is run via its shortcut.

Enabling or Disabling Add-Ins from the Registry

Users can disable or enable a given add-in directly via the Tools -> Add-Ins command. Add-ins can also

be disabled via the Windows Registry as described below.

There are two keys to consider when disabling an add-in for a given user:
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\AddIns\AddInName
HKEY_CURRENT_USER\SOFTWARE\Mindjet\MindManager\14\AddIns\AddInName

where AddInName is the actual name of the add-in (e.g. Mindjet. Mm14Word.AddIn.x).

When a given user starts the application, the program checks first in the HKEY_CURRENT_USER
subkey for a “LoadBehavior” value. If it exists, it is used.

If the “LoadBehavior” value does not exist, the application copies the LoadBehavior value from the
HKEY_LOCAL_MACHINE subkey to the HKEY_CURRENT_USER subkey and then uses that value.

Therefore, to disable an add-in for the current user, set the LoadBehavior value in the
HKEY_CURRENT_USER subkey to 0.

To disable the add-in for all new users, set the LoadBehavior value in the HKEY_LOCAL_MACHINE
subkey to 0.

Note: This has no effect on users that have already run the application at least once. For them you must
set LoadBehavior in the HKEY_CURRENT_USER subkey.

Similarly, setting LoadBehavior to 2 enables the add-in again.

Managing Microsoft Office Add-Ins

When the application is installed, it registers add-ins for MS Office products. The location of this add-in
registration in the Windows Registry depends on the application and the add-in.

For example, the add-in for Microsoft Word is registered on a per-machine basis (so all users of the
machine have it) at:

HKEY_LOCAL_MACHINE\SOFTWARE\WMicrosoft\Office\Word\Addins\Mindjet.Mm14Word.A
ddin.x

Note that Word handles the Tools ->"COM Add-Ins" command and user interface differently than
MindManager.

* InWord, if an add-in is registered in HKEY_LOCAL_MACHINE (HKLM), then it is not displayed in
the COM Add-Ins dialog.

» If an add-in is registered in HKEY_CURRENT_USER (HKCU), it is displayed in the dialog and
can be turned off and on.
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= If the add-in is registered both in HKLM and HKCU, Word ignores the HKCU entry and just uses
the HKLM entry.

The registry data values for the Microsoft program add-ins are the same as described for the add-ins, and
can be edited in a similar fashion.

Managing from the Registry

To allow system administrators to control the environment presented to their users, the application
supports registry settings, which can be set via the user interface. However, registry settings relevant to
Large-Scale Deployment are not available from this user interface. See also the user data installation
options on page 5, which are similarly adjusted via registry settings.

HKEY_LOCAL_MACHINE Settings
The following registry settings are used on a per-machine basis:
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Registration

Table 16: HKEY_LOCAL_MACHINE Registration Values

ShowlLicense REG_DWORD 0 to not show the license key being used or allow
it to be changed.

1 to show the license key
ChangelLicense REG_DWORD 0 to prevent changing the license key.
1 to allow the license key to be changed.

The following registry settings are used on a per-machine basis:
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Settings

Table 17: HKEY_LOCAL_MACHINE Settings

LocalUserDataDirectory @ REG_SZ Path to copy user data files (e.g. Image Library
files, etc.) at first launch. May contain
environment variables.

For example:
N:\UserData\%USERNAME%\MindManager 14
If no path is specified, then this path is assumed:
%USERPROFILE%\Local Settings\
Application Data\MindManager\14

This setting can be overridden by the same
setting in HKEY_CURRENT_USER (see below)
or by the LSDUserDataPath setting described
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PerUserlnstallation REG_DWORD

EnableTellAFriend REG_DWORD

HKEY_ CURRENT_USER Settings

earlier.

0 for per-machine license key management.
1 for per-user license key management.

0 to never show the Tell a Friend dialog

Note: Not included with default installation, and
can be set in either HKLM or HKCU

The following registry settings are used on a per-user basis:
HKEY_CURRENT_USER\SOFTWARE\Mindjet\MindManager\14\Settings

Table 18: HKEY_CURRENT_USER Settings

AllowUpdateCheck REG_DWORD
DisableAnimation REG_DWORD
LocalUserDataDirectory = REG_SZ

EnableTellAFriend REG_DWORD

0 to hide the Help, Check for Updates command.
1 to show this command.

2 to show this command only if the user has write
privileges to HKEY_LOCAL_MACHINE (default)

0 to allow animation of maps for smoother
scrolling.

1 to disable animation of maps for one-jump
scrolling, which is less graphics intensive and
perhaps more desirable in a low-bandwidth
Windows Terminal Server environment.

Path to copy user data files (e.g. Image Library
files, etc.) to when a new user first launches. May
contain environment variables.

For example:
N:\UserData\%USERNAME%\MindManager 14
If no path is specified, then this path is assumed:

%USERPROFILE%\Local Settings\Application
Data\MindManager\14

This setting can be overridden by the
LSDUserDataPath setting described earlier.

0 to never show the Tell a Friend dialog

Note: Not included with default installation, and
can be set in either HKLM or HKCU
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Managing with Event Macros

The application can trigger certain Event Macros that can help system administrators monitor the usage
of the program more carefully.

= These macros are examples only. You need to customize them for your environment.

= Microsoft added the Outlook Object Model Guard starting with Outlook version 2002, forcing the
display of an alert message informing the user that a program is trying to access or send a
message via Outlook, which the user must approve before proceeding. This behavior can be
controlled by Outlook system policies.

Table 19: Event Macros

EVENT NAME WHEN FIRED
OnApplicationStarted At the end of Initinstance (only when started in “normal” mode, not
/RegServer, /UnregServer, etc.)
OnExpiredTrialStarted Just before the “Trial Expired” dialog
OnFirstUse Just before installation of “per-user data”
OnBuyButtonPressed Just before the “Buy MindManager” dialog is displayed

When a macro event is fired, 0 or more macros are run. The mapping of macro event names to macro
filenames is determined on startup.

On startup, the application looks in the registry at
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\ MindManager\14 for a key named Event Macros. If it
is found, expect to find keys such as these:

Event Macros\
OnApplicationStarted\
EventMacro_OnApplicationStarted.mmbas

EventMacro_OnApplicationStartedTwo.mmbas

Path="C:\Temp\EventMacro_OnApplicationStartedTwo.mmbas"
OnBuyButtonPressed\
EventMacro_OnBuyButtonPressed.mmbas
OnExpiredTrialStarted\
EventMacro_OnExpiredTrialStarted.mmbas
OnFirstUse\
EventMacro_OnFirstUse.mmbas

Each event key can have 0 or more macro key names. Each macro key can have an optional “Path”
value.

= If the “Path” value is not there, then the key name is the path.

= |f the path is a relative path (e.g. "EventMacro_OnApplicationStarted.mmbas"), it is converted
to an absolute path relative to the default macro folder for the user (e.g. "C:\Documents and
Settings\UserName\Local Settings\Application Data\Mindjet\MindManager\14\macros").
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If the “Event Macros” key is not in the registry, then the application looks for event macros in the default
macro folder (see above) with a name of the form:

EventMacro_<EventName>.mmbas

For example:
EventMacro_OnApplicationStarted.mmbas

Therefore, it is possible to get macro events to run a macro simply by putting macros with the proper
name in the user's macro folder. However, for most typical IT uses, the “Event Macros” key will be used,
since this can point to macros on a network drive, for example.

For example, this "EventMacro_OnApplicationStarted.mmbas" macro uses the Outlook object model
to send a notification email:

'#Uses "EventMacro_Utilities.mmbas”
Sub Main
SendNotificationEmail "MindManager event: Application Started"
End Sub
Where the “EventMacro_Utilities.mmbas” file contains:

' Utilities for use with MindManager event macros

Public Sub SendNotificationEmail(eventString As String)
' Sends the subject string to the appropriate IT person

' to notify them of the MindManager event that just occurred

' Get access to our email program
Dim outlookApp As Outlook.Application
Set outlookApp = New Outlook.Application

' Create a message

Dim message As Outlook.Mailltem

Set message = outlookApp.Createltem(olMailltem)
message.To = "System Administrator”
message.Subject = eventString

message.Body = eventString

' Send the message
message.Send
End Sub
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Managing User Licenses

Each user must have a license. Please contact your reseller or Mindjet sales representative for licensing
terms appropriate for Large-Scale Deployment. MindManager does not include any special support for
proprietary third-party license management software.

MindManager can check and administer license keys on a per-user or per-machine basis. The application
first looks for a license key in:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Registration\

The default installation administers license keys on a per-machine basis. A license key can be entered
after the program is installed, and all users of that machine have access to the program via that key.

To achieve per-user license key administration:

1. Install with no license key: use the installation wizard (which does not ask for a key), or use
command-line installation without specifying a license key.

Or, set the registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\WMindjet\MindManager\14\Settings\PerUserInstallatio
n to 1 after installation. This setting instructs the application to save any license key the user
enters to the HKCU setting instead of the HKLM setting.

2. The administrator should put the user's license key in the user's HKCU registry setting (above)—
or provide the user with the license key so s/he can enter it in the license key dialog that is
automatically displayed upon launching in Trial mode.

Policies Support

The application does not offer official Windows Policies support.

MindManager Linker for SharePoint
Note: To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise, which includes MindManager Linker for SharePoint.

MindManager Linker for SharePoint supports an optional silent argument for deploying a SharePoint
SITECONNECTIONFILE as a way to pre-populate custom SharePoint connections.

Optional silent install argument:
SITECONNECTIONFILE=full_path_to_custom_site_connection_file

This file can have any name but must be reachable from install-to machine. The file is copied to
“SiteConnections.xml” in the SharePoint Linker INSTALLDIR.

Note: This argument will have no operational effect when the application runs if the SharePoint Add-In is
not active.

Proxy Server Support

The application supports proxy server connections to the internet, including overriding default Microsoft
Internet Explorer settings.
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Mindjet Options

General Proxy Settings

View A

Edit Pfoxy type:

Visual Effects () Mo proxy

Open &fSave © Use default Windows settings
User Information

Notes () HTTPJHTTPS:

Spelling t

Topic Alerts

Review

Security

Add-Ins v

Transformations [¥] User name and password are required
Package Folders et rie:

Online Access

Task Info

Databases Password:
SharePoint

[V]Remember username and password between application sessions

If a domain is needed, include it with your user name like this:
"domainiusername”.

QK ] [ Cancel

Primary path:
1. Select Proxy Settings from MindManager - File > Options.

2. Choose Auto-detect/Use system proxy settings (e.g. set by system or w/in IE) or Manual proxy
configuration (no proxy, https).

3. Set proxy settings for manual proxy configuration.

Alternate path:
1. System administrator sets proxy settings (Host & Port) for Large-Scale Deployment.

2. When installed, MindManager options are configured based upon on System Administrator user's
configuration.

3. System Administrator has an option to hide the ability to remember Username and Password for the
HTTPS proxy settings.

Impacted areas:

* Online (Files) - New/From Maps for that Gallery, Signin/out, and Tasks.
* Notifications; Creating/deleting files; folders, Co-editing and Sharing.

* Trial display messages emanating from Mindjet servers.

* Tasks
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* Connection — sign in/sign out

* Design partner

* Check for updates

* All the web services Map Parts
* SharePoint Add-in *

* Database linker

* To use MindManager with Microsoft SharePoint, you must purchase and install MindManager
Enterprise.
The registry settings are as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Settings\ProxyType = 0 (no proxy) -
DWORD type

1 = Use default windows settings

2 = Use custom proxy settings

In case your proxy type is set to custom, you can set a custom proxy as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Settings\ProxyHost = host name -
STRING

HKEY_LOCAL_MACHINE\SOFTWAREMindjet\MindManager\14\Settings\ProxyPort = port name -
DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Settings\ProxyAuthenticationRequired -
DWORD (can be O or 1)

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\14\Settings\ProxySaveCredentials -
DWORD (can be 0 or 1) - is used to save proxy credentials across application sessions
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